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INTRODUCTION

This database contains a subset of data from Snapshot Wisconsin cameras deployed in two different
Wisconsin ecoregions: Southern Wisconsin Till Plains (SWTP) and Northern Lakes and Forests (NLF). The
columns of the spreadsheet refer to different pieces of metadata, metadata is defined as a set of data
describing and giving information about other data (in this case the trail camera photos). The metadata
describes the compass bearing of the trail camera, height from the ground, height from the trail, trigger
ID (the name that the photo is stored as), camera number, animal, number of animals, data the photo
was taken, time, and temperature.

These step-by-step instructions are designed to help students take a raw dataset and convert it into a
series of Pivot Tables. The Pivot Tables will allow students to view the abundance of species for specific
ecoregions, and calculate biodiversity indices.

PART I: ACCESSING THE DATABASE

1. Download “Measuring Biodiversity Database.xIsx” file and open on your computer in Microsoft
Excel.
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1 |Compass [Height fro Height fro Trigger ID Camera NAnimal Number ¢Date Time Temp
2 92 3 13 SSWI000000000712960 NLF2Z BEAR 2 9-Jul-15 20:39:33 68
3 92 3 13 SSWI000000000712961 NLF2Z BEAR 3 9-Jul-15 20:39:55 68
4 92 3 13 SSWI000000000712962 NLF2 BEAR 1 10-Jul-15 08:02:07 59
8 92 3 13 SSWI000000000712963 NLF2 BEAR 1 10-Jul-15 08:02:29 59
6 92 3 13 SSWI000000000712966 NLF2 TURKEY 1 11-Jul-15 14:25:44 80
7 92 3 13 S5WI000000000712969 NLF2 BEAR 1 13-Jul-15 21:58:01 64
3 92 3 13 S5WI000000000712970 NLF2 BEAR 1 13-Jul-15 21:58:23 64
9 92 3 13 55WI000000000712974 NLF2 COYQTE 1 17-Jul-15 05:08:12 62
10 92 3 13 55WI000000000712976 NLF2 BEAR 1 17-Jul-15 22:08:41 70
1n 92 3 13 55WI000000000712980 NLF2 BEAR 1 20-Jul-15 05:22:39 62
12 92 3 13 55WI000000000712981 NLF2 BEAR 1 20-Jul-15 05:23:32 62
13 92 3 13 55WI000000000712982 NLF2 BEAR 1 20-Jul-15 05:23:58 62
14 92 3 13 S5WI000000000712995 NLF2 BEAR 1 29-Jul-15 16:15:29 71
15 92 3 13 S5WI000000000712996 NLF2 BEAR 1 29-Jul-15 16:16:04 71
16 92 3 13 S5WI000000000712997 NLF2 BEAR 1 29-Jul-15 16:16:29 73
17 92 3 13 SSWI000000000713002 NLF2Z COYOTE 1 30-Jul-15 17:12:12 73
18 92 3 13 SSWI000000000713005 NLF2 DEER 1 1-Aug-15 11:45:39 71
19 92 3 13 SSWI000000000713006 NLF2Z DEER 1 1-Aug-15 11:46:01 71
20 92 3 13 SSWI000000000713014 NLF2Z BEAR 1 6-Aug-15 00:28:32 57
21 92 3 13 SSWI000000000713015 NLFZ BEAR 1 6-Aug-15 00:28:34 a7
22 92 3 13 SSWI000000000713033 NLFZ DEER 1 16-Aug-15 17:34:20 77
23 92 3 13 SSWI000000000713037 NLF2Z DEER 1 17-Aug-15 11:25:25 64
24 92 3 13 SSWI000000000713078 NLF2Z DEER 1 25-Aug-15 16:34:34 29
25 92 3 13 SSWI000000000713104 NLF2Z GROUSE 1 39-Sep-15 07:03:49 46
26 92 3 13 SSWI000000000713113 NLF2 DEER 1 13-Sep-15 19:13:43 62
27 92 3 13 SSWI000000000713114 NLF2 DEER 1 13-Sep-15 19:14:10 62
28 92 3 13 SSWI000000000713137 NLF2 TURKEY 5 29-Sep-15 10:27:32 50
29 92 3 13 S5WI000000000713138 NLF2 TURKEY 6 29-Sep-15 10:28:00 50
30 92 3 13 S5WI000000000713139 NLF2 TURKEY 5 29-Sep-15 10:28:27 50
31 92 3 13 55WI000000000713140 NLF2 TURKEY 4 29-Sep-15 10:28:50 50

Step 1. View of Measuring Biodiversity Database in Microsoft Excel.

PART II: CONDENSING THE DATA
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2. Highlight the “Camera Number” column by clicking on the “E” button above the heading. Under
the Data tab, click the Filter tool. A downward facing arrow will now appear on the “Camera
Number” heading. Click on the downward facing arrow, click “Clear” and then select the
cameras appropriate for the ecoregion of interest (Southern Wisconsin Till Plains or Northern
Lakes and Forests, whichever you start with — you will calculate the other later). Click “OK”.
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1 |Compass EHeight fro Height fro Trigger ID |CamerE irfal Number ¢ Date Time Temp
2 92 3 8] SortAtoZ 2 9-Jul-15 20:29:33 68
3 92 3 Z| sotZtoA 3 9-Jul-15 20:39:55 68
4 92 3 Sort by Color , BEAR 1 10-Jul-15 08:02:07 39
5 92 3 BEAR 1 10-Jul-15 08:02:29 39
6 92 3 TURKEY 1 11-Jul-15 14:25:44 80
7 92 3 BEAR 1 13-Jul-15 21:58:01 64
8 92 3 Text Filters » |BEAR 1 13-Jul-15 21:58:23 64
9 92 3 COYOTE 1 17-Jul-15 05:08:12 62
Search pel
10 92 3 BEAR 1 17-Jul-15 22:08:41 70
11 92 3 BEAR 1 20-Jul-15 05:22:39 62
12 92 3 BEAR 1 20-Jul-15 05:23:32 62
13 92 3 BEAR 1 20-Jul-15 05:23:58 62
14 92 3 BEAR 1 29-Jul-15 16:15:29 71
15 92 3 BEAR 1 29-Jul-15 16:16:04 71
16 92 3 BEAR 1 29-Jul-15 16:16:29 73
17 92 3 COYQOTE 1 30-Jul-15 17:12:12 73
18 92 3 DEER 1 1-Aug-1511:45:39 71
13 92 3 DEER 1 1-Aug-15 11:46:01 71
20 92 3 cancel | [BEAR 1 6-Aug-15 00:28:32 57
21 92 3 BEAR 1 6-Aug-15 00:28:54 57
22 92 3 13 SSWI000000000713033 |NLF2 DEER 1 16-Aug-15 17:34:20 77
23 92 3 13 SSWI000000000713037 |NLF2 DEER 1 17-Aug-15 11:25:25 64
24 92 3 13 S5WI000000000713078 |NLF2 DEER 1 25-Aug-15 16:34:34 39

Step 2. Filtering the data for only cameras from ecoregion of interest, in this case Southern Wisconsin Till Plains.

3. Google Sheets will now show a condensed version of the data only displaying the ecoregion of
interest. Highlight the filtered data by clicking in the upper left corner of the Microsoft Excel (to
the left of the A column, above row 1). Use Ctrl + C to copy the data. Navigate to the Workspace
sheet, click in the upper left corner (to the left of the A column, above row 1) and paste the data
in the Workspace sheet using Ctrl + V.

This will allow you to manipulate the data that you want, while leaving the original dataset
intact. In the original Database sheet, select the Data tab and select the Filter tool again (which
should be grayed out) to restore the original dataset.
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mﬁmpass IHeight fro Height fro Trigger ID CamerAnimaI Number ¢ Date Time Temp
2 92 3 13 SSWI000000000712960 NLF2 BEAR 2 9-Jul-15 20:39:33 68
3 92 3 13 SSWI000000000712961 MNLF2 BEAR 3 9-Jul-15 20:39:55 68
4 92 3 13 S5WI000000000712962 NLF2 BEAR 1 10-Jul-15 08:02:07 59
3 92 3 13 S5WI000000000712963 NLF2 BEAR 1 10-Jul-15 08:02:23 39
6 92 3 13 $5WI1000000000712966 NLF2 TURKEY 1 11-Jul-15 14:35:44 80
7 92 3 13 SSWI000000000712969 NLF2 BEAR 1 13-Jul-15 21:58:01 64
8 92 3 13 SSWI000000000712970 MNLF2 BEAR 1 13-Jul-15 21:58:23 [2)
9 92 3 13 SSWI000000000712974 NLF2 COYOTE 1 17-Jul-15 05:08:12 62
10 92 3 13 S5WI000000000712976 NLF2 BEAR 1 17-Jul-15 22:08:41 70
11 92 3 13 S5WI1000000000712980 NLF2 BEAR 1 20-Jul-15 05:22:39 62
12 92 3 13 S5WI000000000712981 NLF2 BEAR 1 20-Jul-15 05:23:32 62
13 92 3 13 SSWI000000000712982 NLF2 BEAR 1 20-Jul-15 05:23:58 62
14 92 3 13 S5WI000000000712995 MNLF2 BEAR 1 29-Jul-15 16:15:29 71
15 92 3 13 SSWI000000000712996 MNLF2 BEAR 1 29-Jul-15 16:16:04 71
16 92 3 13 S5WI000000000712997 MNLF2 BEAR 1 29-Jul-15 16:16:29 73

Step 3. Where to click in upper left corner to highlight entire sheet of data, and to paste in Workspace sheet.

4. For this exercise, we are only interested in the abundance of animals in each ecoregion. In the
Workspace sheet delete all columns, except for “Animal” and “Number of animal”, by right
clicking on the column heading letter and selecting “Delete.” You can select multiple columns to
delete by using the Ctrl button while you select columns.
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Step 4. View of condensed data of interest in Workspace sheet.

PART lll: CREATING A PIVOT TABLE

5. The next step is to create a Pivot Table to summarize the data. Highlight the “Animal” column by
clicking on the “A” column heading. While these column is highlighted, click on the Insert tab
and select “Recommended Pivot Tables.” Choose the second option, “Sum of Number of animals
by Animal.” (if you select the first option, “Count of Animal” this will not take into consideration
if a camera trigger has multiple individuals for example, if a trail camera shows three deer will
only appear as one under these settings).
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Step 5. Under “Recommended Pivot Tables” select the second option, “Sum of Number of animals by Animal.”
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Row Labels ~  Sum of Number of animals
BEAR 66
BOBCAT 2
CAT 3
COTTONTAIL 98
COYQTE 38
DEER 1107
DoG 4
ELK 108
FISHER 1
GRAY FOX 16
GROUSE b
OTHER BIRD 9
OTTER 1
OWL 1
RACCOON 57
RED FOX 48
SAMNDHILL CRAMNE 21
SNOWSHOE HARE 9
SQUIRREL 60
STRIPED SKUMNK 23
TURKEY 62
WHOOQOPING CRAMNE 1
WOLF 9
Grand Total 1750

Step 5. Example of what your Pivot Table should look like.

PART IV: PERFORMING CALCULATIONS IN MICROSOFT EXCEL

6. A Pivot Table will be created in a new sheet, your Pivot Table should display each species and
the total number of sighting on the trail cameras. Rename the headings to “Species” and
“Abundance”, and create new headings for P;, In(P;), and Pi*In(P;) in the adjacent columns.

7. To have Microsoft Excel calculate the P; value, enter in =(CELL_LOCATION / Total Abundance).
For this exercise, the Grand Total value reflects the total number of individuals, do not reference
the cell of the total abundance, or the following step will not work correctly. For example, enter
=(B4/1750). (Be aware of where Microsoft Excel has created the Pivot Table, this will impact
what cell number you are using, for example B4). To autofill the P; value for each species, click
on the calculated cell and drag down green square in the bottom right corner.
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HYPERLINK ~ X v =B4/1750

A B C D E F G
1 -
2 -
3 |Species - | Abundance Pi In{Pi) Pi*In(Pi)
4 |sear I 66|=54/1750 |
5 |BOBCAT 2
6 |CAT 3
7 | COTTONTAIL 98
8 |COYOTE 38
5 |DEER 1107
10 |DOG 4
11 |ELK 108
12_ FISHER 1
13 |GRAY FOX 16
14 |GROUSE
15_ OTHER BIRD 9
16 |OTTER
17 |owL 1
18 |[RACCOON 57
19 |RED FOX 48
20_ SANDHILL CRANE 21
21 | SNOWSHOE HARE 9
ZZ_SQUIRREL 60
23 |STRIPED SKUNK 23
24 | TURKEY 62
: >
QL Grand Total 1750
23_""""—
29|

Step 7. Example of what your Pivot Table should look like with added columns for Microsoft Excel to help organize
calculations, the red circles show the total abundance and equation for calculating Pi.

8. Use Microsoft Excel to calculate In(P;) by typing in the equation =In(CELL_LOCATION) into the
corresponding cell. For example, =In(C4) (these cell locations may vary based on your dataset)



Page 8 of 10

e
Qm Measuring Biodiversity: Microsoft Excel Tutorial
SNAPSHOT
WISCONSIN
HYPERLINK ~ X « & | =In(ca)
A , B . C D E F G
1_
2_
3 |Species - | Abundance Pi n{Pi) FIn(Pi)
4 |BeAr 66 0.037Q4l=In{ca)| |
5 |BOBCAT 2 0.0011
6 |CAT 3 0.001714
7 |COTTONTAIL 98 0.056
8 |COYOTE 38 0.021714
9 |DEER 1107 0.632571
10 |DOG 4 0.002286
11 [ELK 108 0.061714
12 |FISHER 1 0.000571
13 | GRAY FOX 16 0.009143
14 | GROUSE 6 0.003429
15 |OTHER BIRD 9 0.005143
16 |OTTER 1 0.000571

Step 8. Calculation for In(P;).

9. Calculate Pi*In(P;) using the equation =(CELL_LOCATION * CELL_LOCATION). For example,
=(C4*D4) (these cell locations may vary based on your dataset)
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A B C D E F G H

1 .
2 .
3 |Species - | Abundance Pi In{Pi) Pi*In(Pi)
4 |BEAR 66l 0.037714] -3.2
5 |BOBCAT 2 0.001143 -6.7742
6 |CAT 3 0.001714 -6.36876
7 |COTTONTAIL 98  0.056 -2.8824
8 |COYOTE 38 0.021714 -3.82978
9 |DEER 1107 0.632571 -0.45796
10 |DOG 4 0.002286 -6.08108
11 |ELK 108 0.061714 -2.78524
12 |FISHER 1 0.000571 -7.46737
13 |GRAY FOX 16 0.009143 -4.69478
14 |GROUSE 6 0.003429 -5.67561
15 |OTHER BIRD 9 0.005143 -5.27015
16 |OTTER 1 0.000571 -7.46737

Step 9. Calculation for P; * In(P).

10. Calculate the Shannon diversity index using the equation H = -SUM (P; * In(P;)). You can perform
this calculation in Microsoft Excel using the equation
=-SUM(FIRST_CELL_LOCATION:LAST CELL LOCATION). For example, =-SUM(E4:E26) (these cell
locations may vary based on your dataset).
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|Species - | Abundance Pi
BEAR 66 0.037714
BOBCAT 2 0.001143
CAT 3 0.001714
|COTTONTAIL 98 0.056
|COYOTE 38 0.021714
|DEER 1107 0.632571
DOG 4 0.002286
ELK 108 0.061714
FISHER 1 0.000571
|GRAY FOX 16 0.009143
GROUSE 6 0.003429
OTHER BIRD 0.005143
|OTTER 1 0.000571
owL 1 0.000571
RACCOON 57 0.032571
RED FOX 48 0.027429
SAMDHILL CRAME 21 0.012
SNOWSHOE HARE 9 0.005143
SQUIRREL 60 0.034286
STRIPED SKUNK 23 0.013143
TURKEY 62 0.035429
WHOOPING CRANE 1 0.000571
WOLF 9 0.005143
Grand Total 1750

In(Pi)

Pi*In(Pi)

-3.27772
-6.77422
-6.36876
-2.5824
-3.82978
-0.45796)
-6.08108
-2.78524
-7.46737
-4.69478
-5.67561
-5.27015
-7.46737
-7.46737
-3.42432
-3.59617
-4.42285
-5.27015
-3.37303
-4.33188
-3.34024
-7.46737
-5.27

-0.12362
-0.00774
-0.01092
-0.16141
-0.08316
-0.28969

-0.0139
-0.17189
-0.00427
-0.04292
-0.01546

-0.0271
-0.00427
-0.00427
-0.11153
-0.09364
-0.05307

-0.0271
-0.11565
-0.05693
-0.11834
-0.00427

-0.0271

= SUM(E4:E26)|

Step 10. Calculation for finding the Shannon diversity index.

11. You can use a calculator to calculate Evenness (E), or take advantage of Microsoft Excel to do
this calculation for you! Use some of the techniques that you have learned in this tutorial.
12. Repeat these steps for the next ecoregion. Record your answers in your Student Worksheet.



